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What’s New at Amicus Attorney?
  
AMICUS ATTORNEY V+

This great new upgrade to the Amicus V platform includes a new Notes module, new 
e-mail notifications, improved calendar reminders, expanded core module views, Palm® 
link enhancements, integration with HotDocs® 6 plus a whole lot more.

Current Amicus Attorney V customers can upgrade to V+ for only $99 a license!

For more information on upgrading to Amicus V+: 

www.amicusattorney.com/Upgrade2V+/index.html

Amicus Assembly Customers - Save When You Upgrade to 
NEW GhostFill® 5.0

If you are a current Amicus Assembly customer, contact our sales team to find out how 
you can upgrade your Amicus Assembly engine to the latest GhostFill 5.0 version and 
SAVE! 

Current Amicus Assembly customers can save between 35% and 65% on upgrades.

GhostFill® Version 5.0 features:

• Improved layout for dialog headings including navigation buttons
• New formatting options
• New GhostPad text editor/viewer
• New GhostFill “Link” templates

 

  

Do you know others 
who would like to 

receive this newsletter? 
Simply send this issue 
to them and with one 

click of the SUBSCRIBE 
button, they’ll start 
receiving it monthly.

 

Your monthly dose of 
humor... 

 

No problem. Click here 
to view or print from our 

past issue archives.
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• New End-User view
• New PDF controls
• Improved Help Menu
• PLUS MORE!

For more information or to upgrade to GhostFill 5.0 contact us today!
800-472-2289 or sales@amicusattorney.com. 

You Have to Try This!
Practical Tips and Tricks from Amicus Attorney Certified Consultants

In the December 2003 issue of the Amicus Attorney News we covered how to create labels using information from 
Amicus Attorney to make addressing those holiday cards and packages easier. We also included tips on how to 
create contact groups so that you could easily identify who was on your holiday list. 

To view a copy of this issue visit our online archives here: www.amicusattorney.com/news/news_aa_news.html

It’s that time of year again – so we are bringing you some more tips for making your holiday mailings easy!

Marking a Contact and Copying an Address to an Envelope
By: Lori Berenson of Productivity Consulting, Inc.

Contact Groups:

Adding a specific group to a contact allows you to easily do mailings (letters, envelopes, labels, or postcards). You 
can add a group to your Amicus Attorney database specifically for Holiday Mailings. You can then print fancy labels 
and/or lists of who will receive those mailings. (Note: Contact Groups are covered in more detail in the December 
2003 issue)

Marking a Contact:

Selecting contacts by group is one way to do a large mailing. However, you may also want to create a temporary 
group for a one-time mailing.

Do this:  To see this:

Select CONTACTS – Show Marked from 
the menu bar.

 To view a list of previously marked contact cards. 
Contacts remain marked until they are “unmarked”.

Press Ctrl - A (or select CONTACTS – 
Show All from the menu bar).

 To view all contact cards.

MARKING A CARD - Click on the yellow 
corner of a card to mark the card. The 
corner is now gray with a checkmark, and 
appears to be folded down.
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UNMARKING A CARD - Click on the 
checked corner of a card to unmark the 
card. Now the corner is yellow and 
appears to be unfolded.

 

Select CONTACTS – Generate a 
Document from the menu bar.

Click on the Marked radio button and 
select a Master Document to merge with 
the list of marked contacts.

 

Copying an Address

If you only have a few mailings to do, you can easily copy the name, title, company and address of a contact to the 
Windows clipboard, and then paste it into your word processing document (or anywhere else). This can be done 
while highlighting a contact’s name in the Contact Index, or viewing a person’s contact card.

To copy an address, display the contact containing the address you want to copy, then press Ctrl - R (or select Edit - 
Copy Address from any Amicus pull-down menu). You may then paste the address into any other application.

Copy an Address to an Envelope 

What you do:  Comments/Prompts:

1. With any contact’s name 
highlighted, press Ctrl - R.

 Ctrl - R is a keyboard shortcut for copying a contact’s name, title, 
company and address to the Clipboard. You could also select 
Edit – Copy Address from the menu bar.

2. Follow the instructions beginning 
with step #3 if you are using 
WordPerfect.

Follow the instructions beginning 
with step #7 if you are using MS 
Word.

 If you have both Word and WordPerfect, you may want to 
practice both methods.

 

WORDPERFECT USERS

file:///G|/www/newsletter/index_nov2004.html (3 of 15)11/16/2004 11:48:00 AM



Amicus Attorney Newsletter

3. Click on the WordPerfect button 
on the Windows Taskbar.

Select _Format_Envelope_ from 
the WordPerfect menu bar.

 If WordPerfect is your default generation method and it is not 
open, you may open it from the Tools pull-down menu.

4. Click in the Mailing address field 
and press Ctrl - V to paste the 
address.

NOTE: If your address is too long 
to display in the ‘Mailing address’ 
field, press the scroll arrow (on the 
keyboard) to move to the 
beginning of the address.

Click on the Bar Code icon.

 Ctrl - V is the Windows shortcut for Paste. You will not be able to 
click on the ‘Paste’ icon on the WordPerfect Toolbar or select 
Paste from the Edit pull-down menu.

5. Select one of the ‘Position’ radio 
buttons and click on OK.

 

 Click on Append to Doc and the 
envelope is added as a new page 
at the end of the document.

Or click on Print Envelope to print 
without adding the new page.
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Your completed envelope will look like this:

 

6. Close the document.

Click on the Amicus Attorney 
button on the Windows Taskbar.

 If you see a prompt asking you to save the document, click on 
No.

You will return to the Contacts Index.

MS WORD USERS

7. Click on the Word button on the 
Windows Taskbar (if Word is 
already open)

Open a new blank document (if 
you do not have one open already)

Select _Tools_ 
_Envelopes_and_Labels_

 If Word is not open, it may be listed in your Tools pull-down 
menu.

Press Ctrl - N (or select File – New from the menu bar).

8. Press Ctrl - V to paste the address 
in the ‘Delivery address’ field.

NOTE: If your address is too long 
to display in the ‘Delivery address’ 
field, you may use the scroll 
arrows to move to the beginning of 
the address.

Click on the Options button 
(unless you have already selected 
the ‘Delivery point barcode’ 
checkbox).

 Another option is to click the right mouse button and select 
Paste.

NOTE: In MS Word, once the ‘Delivery point barcode’ checkbox 
is selected, you do not need to select it again.
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9. If you have not already selected 
Delivery point barcode, click on 
the checkbox and click on OK.

 

 Click on the Add to Document 
button and the envelope is added 
as a new page at the beginning of 
the document.

Or click on Print to print without 
adding a new page.

 

 

Your completed envelope will look like this:

 

10. Close the document.

Click on the Amicus Attorney 
button on the Windows Taskbar.

 If you see a prompt asking you to save the document, click on 
No.

You will return to the Contacts index.

Compliments of:

Lori Berenson
Productivity Consulting, Inc.
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Cleveland, OH
(216) 373-7788 - OnlyOne (voice/fax/cell)
lorib@berenson.net
www.productivityconsulting.net

Lori Berenson is an Amicus Attorney Certified Consultant and author of “Your Step by Step Guide to Amicus 
Attorney”. Lori owns and operates Productivity Consulting, a computer consulting firm based in Northeast Ohio.. 
Since 1985, Productivity Consulting have offered consulting and training to improve office productivity - specializing 
in contact and case management for law offices. Customized training manuals are offered with most of their training 
and consulting services, and can be tailored to fit the needs of clients. 

Spotlight On ...
Highlighting a Feature of Amicus Attorney

The Searchable Knowledge Base

All Amicus Attorney Customers have access to our comprehensive, online, searchable Knowledge Base. This 
Knowledge Base contains information on a wide range of both technical and feature questions. 

If you have a technical question regarding your Amicus Attorney software, use the Knowledge Base to find your 
answer. Some of the most common questions are addressed in this online tool.

Simply enter in a keyword/text you are searching for or the error message you are receiving. You can search across 
all versions or refine your search based on the version of the product you are using.

If you don't initially find what you're looking for, try being less specific and simplify the search. Instead of looking up: 
"How do I move Amicus from one computer to another?", try looking up just "moving". 
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The Search results are displayed as articles. Each article’s title is in bold with a brief overview of what the article 
contains. Clicking on the appropriate title of the desired article provides you with the full article details including the 
Issue, Cause and recommended Solution. The article also includes the versions that the issue is applicable to and 
the date it was last modified. 

The Knowledge Base is continually being added to and modified by our Technical Support Team to ensure that you 
have technical assistance at your fingertips.

Access the Knowledge Base here: www.amicusattorney.com/support/support_searchable_kb.aspx 

Legal Tips 
Tips from Legal Industry Experts on How to Effectively Manage Your Practice
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5 Tips For Improving Your Client Relations
By Edward Poll, J.D., M.B.A., CMC

Here are 5 of the many tips I've learned over the years to help any lawyer develop good client relations.

1.  Believe that the client is number one. Attorneys need to take a customer service approach to dealing with 
clients. This may be a new concept for lawyers brought up on the idea of "client control," which basically 
means that the lawyer is the boss and the client better stay out of the way! Client control is an antiquated 
concept, and it has no place in the modern practice of law. 

2.  Return phone calls. Sounds simple, yet the single most frequently registered complaint with state bars across 
the country is the failure of attorneys to return their telephone calls. I know one attorney who has a very 
successful practice, and who keeps getting return clients. I asked him how he did it, and he let me in on his 
secret: he makes a point of returning all telephone calls within four hours. 

3.  Visit the client. You can learn a great deal about clients by visiting them in their place of business. A letter or a 
phone call can only go so far. In order to really understand clients, you need to learn about the territory where 
they live or work. 

4.  Advise your clients about changes in the law that impact them. By sending a note, clipping or letter 
highlighting changes in the law that have occurred in your area of expertise, clients will know that you're up to 
date and that you care about them. This is also a great marketing opportunity, because by sending clients 
information of related interest, you can let them know that you also perform services in these other areas. 

5.  Communicate regularly with your clients. It's important to let clients know what's happening with their matter, 
and one way to do that is to send status reports on a regular basis. Even if there is nothing much to report, tell 
the client that things are going as projected. Think of this communication as a way to educate the client about 
the legal process and as an opportunity for cementing your relationship.

In summary, clients are mostly concerned about your commitment. If you are dedicated to them - and can prove it - 
your clients will come back to you time after time and refer you with a big smile.

Compliments of:

Edward Poll
LawBiz Management Company
Venice, California 
(310) 827-5415
edpoll@lawbiz.com
www.lawbiz.com

Edward Poll, J.D., M.B.A., CMC, is a coach to lawyers and certified management consultant who shows attorneys 
and law firms how to be more profitable. Ed's latest book is Collecting Your Fee: Getting Paid From Intake to Invoice 
(ABA 2003); he is the author of Attorney & Law Firm Guide to The Business of Law, 2d ed. (ABA 2002); Secrets of 
the Business of Law: Successful Practices for Increasing Your Profits.

FAQs - Frequently Asked Questions 
Our Customer Service Team Provides Answers to Some Common Technical Questions
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Why do the fields disappear and only the background color is shown in the fields when pressing the TAB 
key or ALT key within the Amicus Attorney Event, Time Entry, or Phone Call details dialog on my computers 
running Windows 2000 or XP?

Cause: There is a display setting in Windows 2000 and XP that causes this problem to occur.

Solution: You need to perform the following procedure in your Display settings

If you are a Windows XP user:

1. From your Control Panel, open Display.
2. Click the Appearance tab.
3. Click the Effects button.
4. Disable the option, "Hide underlined letters for keyboard navigation until I press the Alt key".
5. Click OK in the Display dialog.
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If you are a Windows 2000 user:

1. From your Control Panel, open Display.
2. Click the Effects tab.
3. Disable the option, "Hide keyboard navigation indicators until I use the Alt key".
4. Click OK in the Display dialog.
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YOUR LEGAL LAUGH
Your monthly dose of humor... 

Compliments of: www.legalhumor.com.

Amicus Attorney Premier Consultants 
Training and More!

Amicus Attorney Premier Consultants are professionals who are nationally qualified to sell and install all Amicus 
Attorney products and to provide their customers with on-site training and support. 

Training Programs Offered by our Premier Consultants: 

Here are a few of the training sessions being offered by some of our Premier Consultants. 
For more information or to register for a class, please contact the consultant firm directly. 
All times listed in ET unless otherwise indicated. 

CD-ROM TRAINING

2b1, Inc. 
San Francisco, CA
(415) 284-2221
www.2b1inc.com

Amicus Attorney V Basic Training: PC Desktop training for the Amicus Attorney user. Easy-to use and easy-to-follow 
animation covers the most used features of Amicus Attorney V.

For more information, visit their web site: 

www.2b1inc.com/t_products.htm

WEB BASED TRAINING

ProBill Law Firm Solutions 
Boca Raton, FL
(800) 299-9177 
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www.probill.net 
administration@probill.net

For more information, contact ProBill Law Firm Solutions via e-mail or phone.

Special training on the new features in Amicus Attorney V+ now scheduled! 
Date Time Training Session Location

Flexible Dates 9:00 am
11:00 am
1:00 pm
3:00 pm 5:00pm
Weekend and 
late nights 
available.

eClass Training (Web Based training) - 
choose from:
Basic Application Training
Advanced Application Training
Application Troubleshooting
Quick Start (New Clients Only)

Web based - You can 
take eclasses directly 
from your own 
computer.

November 29, 2004 9:00 am TRN201 Amicus Attorney V - Basics 
Setting up Contacts, Files and using the Calendar, Telephone & 
Email features

Web based

November 29, 2004 11:00 am TRN202 Amicus Attorney V - Advanced Calendar
Court rules, attaching actions to a calendar event such as 
generating a document or sending an email, working with the 
group calendar and more

Web based

November 29, 2004 1:00 pm TRN203 Amicus Attorney V - Document Assembly
Merge information from Amicus Attorney into your documents 
while linking the document to a File for future reference

Web based

November 29, 2004 3:00 pm TRN204 Amicus Attorney V - The Library
Organize your research materials for easy retrieval, i.e., word 
processing documents, spreadsheets, websites, paid services.

Web based

November 29, 2004 5:00 pm TRN205 Amicus Attorney V - ComCenter
Everything you need to know about managing emails in Amicus 
including attaching emails to Files and Contacts. This class also 
covers other functions of ComCenter namely sending interoffice 
messages and initiating phone calls.

Web based

November 30, 2004 9:00 am TRN206 Amicus Attorney V - Timeslips Link
Use Amicus Attorney to track your time as you work then transfer 
it to Timeslips for billing. Exchange contact information between 
the programs.

Web based

November 30, 2004 11:00 am TRN207 Amicus Attorney V - QuickBooks Link
Use Amicus Attorney to track your time as you work then transfer 
it to QuickBooks for billing. Exchange contact information 
between the programs.

Web based

November 30, 2004 1:00 pm TRN208 Amicus Attorney V – PCLaw Link
Use Amicus Attorney to track your time as you work then transfer 
it to PCLaw for billing. Exchange contact information between the 
programs.

Web based

November 30, 2004 3:00 pm TRN201+ Amicus Attorney V+ NEW FEATURES
Including the Notes module virtual legal pad with ability to cross 
reference to files, enhanced sticky management, e-mail 
notification, Palm link enhancements, additional closed file 
options plus more.

Web based

November 30, 2004 5:00 pm TRN201+ Amicus Attorney V+ NEW FEATURES
Including the Notes module virtual legal pad with ability to cross 
reference to files, enhanced sticky management, e-mail 
notification, Palm link enhancements, additional closed file 
options plus more.

Web based

December 1, 2004 9:00 pm TRN201X Amicus Attorney X – Basics
Setting up People, Files and using the Calendar, Telephone & E-
Mail features.

Web based
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December 1, 2004 11:00 pm TRN202X Amicus Attorney X – Advanced Calendar
Attaching actions to a calendar event such as generating a 
document or sending an e-mail, working with the group calendar 
and more…

Web based

December 1, 2004 1:00 am TRN203X Amicus Attorney X – Document Assembly
Merge information from Amicus Attorney into your documents 
while linking the document to a File for future reference.

Web based

December 1, 2004 3:00 am TRN204X Amicus Attorney X – Library
Organize your research materials for easy retrieval, i.e. word 
processing documents, spreadsheets, websites, paid services.

Web based

December 1, 2004 5:00 pm TRN205X Amicus Attorney X – Communications
Everything you need to know about managing e-mails in Amicus 
including attaching e-mails to Files and Contacts. This class also 
covers other functions of ComCenter namely sending interoffice 
messages and initiating phone calls.

Web based

Pricing: 1st attendee or class - $99 US ($139 CDN), 2nd attendee or class - $89 US ($119 CDN), each additional 
attendee or class - $79 US ($99 CDN)

Events 
Watch for Amicus Attorney at these events.

Some of our top Premier and local consultants will be at these Regional Events demonstrating Amicus Attorney. Stop 
by and get all of your Amicus Attorney questions answered!

For a complete listing of National and Regional Events visit www.amicusattorney.com/news/news_events.html

2004 
Date Event Location

November 30 - Dec. 
1, 2004

Midwest Law & Technology Conference & Expo

This year the Milwaukee Bar Association and the Chicago Bar Association have 
partnered to offer a two day, two city law & technology expo. In addition to legal 
technology CLE, there will be an exhibit hall.

November 30 – 8am - 5pm – Chicago, IL
December 1 – 8am - 5pm – Milwaukee, WI

Amicus Attorney is a Gold Sponsor of this event. Project Planning and Support, Inc 
(www.ppslegal.com) will be on hand in Chicago and Ileene Levine will be in Milwaukee.

For more information contact the Milwaukee or Chicago Bar Associations.

The Conference 
Center / UBS Tower
Chicago, IL

and

The Wyndham Hotel
Milwaukee, WI

January 20 - 22, 2005 South Carolina Bar Convention

For more information or to register, visit: www.scbar.org/member/cle/convention.asp

Best Law Firm Solutions, Amicus Attorney Premier Consultant, will be attending this 
event.
www.bestlawfirm.com

Charleston Place Hotel
Charleston, SC
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You have received this eNewsletter as you are a current Amicus Attorney customer or have previously 
requested information/ this newsletter from our company. To unsubscribe / opt-out from receiving the 

Amicus Attorney News please click here. If you experience any difficulties, please call 800-472-2289 or 
send an e-mail to amicusnews@amicusattorney.com with unsubscribe in the subject line.

© 2004 - Gavel & Gown Software Inc. All rights reserved.
Send comments to: amicusnews@amicusattorney.com. Send product suggestions to: www.amicusattorney.com/forms/product_suggestions.

asp.
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